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1.	Introduction
Chère cliente, cher client,
Merci d’avoir acheté ce produit.
Ce produit est conforme aux exigences nationales et européennes en vigueur.
Afin de préserver cette conformité et de garantir un fonctionnement en toute sécurité, vous devez respecter ce mode 
d’emploi !

	 Ce mode d’emploi fait partie de ce produit. Il contient des informations importantes concernant la mise en 
service et l'utilisation. Vous devez prendre cela en considération si vous devez fournir ce produit à un tiers. 
Par conséquent, conservez ce mode d'emploi afin de pouvoir vous y référer ultérieurement !

Pour toute question technique, veuillez vous adresser à:
France (email): 	 technique@conrad-france.fr
Suisse: 	 www.conrad.ch

2.	Explication des symboles
	 Le symbole avec l’éclair dans un triangle indique qu’il y a un risque pour votre santé, par ex. en raison 

d’une décharge électrique.

	 Le symbole avec le point d’exclamation dans un triangle sert à indiquer les informations importantes pré-
sentes dans ce mode d’emploi. Veuillez lire ces informations attentivement.

	 Le symbole de la flèche indique des informations spécifiques et des conseils spéciaux pour le fonctionnement. 

3.	Utilisation prévue
Le produit est destiné à être utilisé comme un microscope numérique. Il dispose d’un filtre polarisant intégré pour 
réduire l’éblouissement, d’un anneau lumineux LED pour éclairer l’objet et d’une batterie rechargeable pour la portabi-
lité. Les images peuvent être saisies et enregistrées sur une carte MicroSD et le logiciel fourni offre des fonctionnalités 
supplémentaires et la possibilité de faire fonctionner le microscope branché à un ordinateur.
Tout contact avec l'humidité, par ex. dans les salles de bains, doit être évité en toutes circonstances.
Pour des raisons de sécurité et d’homologation, toute restructuration et/ou modification du produit est interdite. Toute 
utilisation à des fins autres que celles décrites ci-dessus pourrait endommager le produit. En outre, une mauvaise 
utilisation vous expose à d’autres risques. Lisez attentivement les instructions du mode d’emploi et conservez-le dans 
un endroit sûr. Ne mettez ce produit à la disposition de tiers qu’avec son mode d’emploi.
Tous les noms d’entreprises et appellations de produits sont des marques commerciales de leurs propriétaires res-
pectifs. Tous droits réservés.
HDMI est une marque déposée de HDMI Licensing L.L.C.
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4.	Contenu de l’emballage
•	 Microscope numérique 
•	 Adaptateur secteur
•	 Câble USB

•	 Câbles HDMI
•	 Accumulateurs
•	 Carte microSD de 4 Go

•	 Adaptateur MicroSD vers SD
•	 Mini trépied
•	 Mode d’emploi

5.	Mode d’emploi actualisé 
Téléchargez le mode d’emploi le plus récent sur www.conrad.com/downloads ou scannez le code 
QR indiqué. Suivez les instructions figurant sur le site Web.

6.	Consignes de sécurité
Lisez attentivement le mode d’emploi et observez particulièrement les consignes de sécurité. Nous 
déclinons toute responsabilité en cas de dommages corporels ou matériels résultant du non-res-
pect des consignes de sécurité et des informations relatives à la manipulation correcte contenues 
dans ce manuel. De tels cas entraînent l’annulation de la garantie.

a)	Informations générales
•	 Cet appareil n’est pas un jouet. Il doit rester hors de portée des enfants et des animaux domestiques.
•	 Ne laissez pas traîner le matériau d’emballage. Celui-ci peut se révéler dangereux si des enfants le 

prennent pour un jouet.
•	 Gardez l’appareil à l’abri de températures extrêmes, de la lumière directe du soleil, de secousses in-
tenses, d’humidité élevée, d’eau, de gaz inflammables, de vapeurs et de solvants.

•	 N’exposez pas le produit à des contraintes mécaniques.
•	 Si une utilisation du produit en toute sécurité n'est plus possible, arrêtez de l’utiliser et protégez-le de 

toute utilisation accidentelle. Un fonctionnement sûr ne peut plus être garanti si le produit :
	- est visiblement endommagé, 
	- ne fonctionne plus correctement, 
	- a été stocké pendant une période prolongée dans des conditions défavorables ou 
	- a été transporté dans des conditions très rudes.

•	 Manipulez le produit avec précaution. Des secousses, des chocs ou une chute, même de faible hauteur, 
peuvent endommager le produit.

•	 Consultez un spécialiste en cas de doute sur le fonctionnement, la sécurité ou le raccordement de l'appareil.
•	 L’entretien, les modifications et les réparations doivent être effectués uniquement par un technicien ou 

un centre de réparation agréé.
•	 Si vous avez des questions dont la réponse ne figure pas dans ce mode d’emploi, contactez notre 

service d'assistance technique ou tout autre personnel technique.
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b)	Appareils connectés
•	 Respectez également les informations concernant la sécurité et le mode d’emploi pour les autres appa-

reils connectés à ce produit.

c)	Éclairage LED
•	 Attention, éclairage LED :

	- Ne regardez pas directement la lumière produite par les diodes LED !
	- Ne regardez pas directement dans le faisceau ni avec des instruments optiques !

d)	Piles/accumulateurs
•	 Retirez les piles/accumulateurs de l’appareil s’il n’est pas utilisé pendant longtemps afin d’éviter les 

dégâts causés par des fuites. Des piles/accumulateurs qui fuient ou qui sont endommagées peuvent 
provoquer des brûlures acides lors du contact avec la peau ; l’utilisation de gants protecteurs appropriés 
est par conséquent recommandée pour manipuler les piles/accumulateurs corrompues.

•	 Gardez les piles/accumulateurs hors de portée des enfants. Ne laissez pas traîner de piles/accumula-
teurs, car des enfants ou des animaux pourraient les avaler.

•	 Les piles/accumulateurs ne doivent pas être démantelées, court-circuitées ou jetées dans un feu.  
Ne rechargez pas les piles non rechargeables. Cela constituerait un risque d’explosion !

e)	Adaptateur secteur
•	 Branchez l’appareil sur une prise murale dont l’accès est facile.
•	 Pour l'alimentation électrique, n'utilisez que l'adaptateur secteur fourni.
•	 Ne branchez l’adaptateur secteur qu’à une prise de courant normale raccordée au réseau public. Avant 
de brancher l’adaptateur secteur, vérifiez si la tension indiquée sur celui-ci est conforme à celle de votre 
fournisseur d’électricité.

•	 Ne branchez ou débranchez jamais les adaptateurs d’alimentation si vos mains sont mouillées.
•	 Ne débranchez jamais l’adaptateur secteur de la prise électrique en tirant sur le câble ; utilisez toujours 
les surfaces de préhension sur la fiche.

•	 En installant le produit, assurez-vous que le câble ne soit ni pincé ni noué et qu’il ne puisse pas être 
endommagé en passant sur des bords tranchants.

•	 Placez toujours les câbles de sorte que personne ne puisse trébucher ou se coincer dessus. Ceci 
présente un risque de blessures.

•	 Pour des raisons de sécurité, débranchez l’adaptateur secteur de la prise électrique en cas d’orage.

f)	 Microscope
•	 La poussière et les déchets présents dans l’air peuvent entraîner la détérioration de la qualité de l’image. 

Tenez l’appareil à l’abri des environnements poussiéreux.
•	 L’appareil peut chauffer pendant l’utilisation. Cela n’indique pas un dysfonctionnement.
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7.	Éléments de fonctionnement
a)	Microscope numérique

1	          Bouton de capture
2	  Zoom
3	 Bague d’objectif polarisant
4	 Indicateur de charge de la batterie
5	 Sortie HDMI
6	 Sortie TV
7	 Port 5 V/USB
8	 Lentille

9	 Point de montage du trépied  
(1/4 de pouce)

10	Logement pour carte microSD
11	 Molette de mise au point
12	Molette de luminosité
13	Compartiment à accus
14	Écran
15	Haut-parleur

16	  Menu de configuration
17	  Alimentation MARCHE/ARRÊT
18	▲Haut
19	  Mode (photo/vidéo/lecture)
20	OK Confirmer
21	▼Bas
22	MIC Microphone

b)	Écran

028825M

2020/09/30 09:32:28

Icône Description

Photo

Vidéo

Lecture
02882 Image restante

5M Résolution de courant
Carte MicroSD insérée

Capacité de l'accumulateur
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8.	Installation
a)	Insertion des accus
1.	 Faites glisser le compartiment à accus pour l’ouvrir et insérez 

la pile comme indiqué.
2.	 Fermez le compartiment à accus.

b)	Charge de l’accumulateur
1.	 Connectez une extrémité du câble de charge au port 5 V/USB du 

microscope, et l’autre extrémité à l’adaptateur électrique fourni. 
2.	 Branchez l’adaptateur à une prise de courant.

	 Le témoin de charge de l’accumulateur s’allume en rouge pendant la charge et s’éteint lorsque l’accumu-
lateur est complètement chargé. L’état de l’accu est indiqué à l’écran.

c)	Insérer et formater la carte MicroSD

1Insérez la carte MicroSD
1.	 Insérez une carte (32 Go max.) dans la fente pour carte Mi-

croSD dans le sens indiqué. Elle se met en place en produi-
sant un « clic ».

2.	 Pour la retirer, utilisez le bout du doigt pour l’enfoncer jusqu’à 
ce qu’elle fasse un « clic », puis relâchez pour l’éjecter.

2Formater la carte MicroSD

 Important : Le formatage efface toutes les données. Veillez à sauvegarder toutes les données importantes 
avant de formater.

1.	 Déployez ou rabattez l’écran ou appuyez sur le bouton d’alimentation  pour mettre le microscope en MARCHE 
ou à l'ARRÊT.

2.	 Appuyez sur  pour accéder au menu de configuration.
3.	 Appuyez sur ▲/ ▼pour aller à « Format », puis appuyez sur OK.
4.	 Appuyez sur OK pour sélectionner « SD card », puis appuyez sur OK pour lancer le formatage.

	 Si vous utilisez un ordinateur pour formater la carte, utilisez le système de fichiers FAT32. Reportez-vous 
aux instructions du système d'exploitation de votre ordinateur pour de plus amples informations, au besoin.
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9.	Fonctionnement
a)	Démarrage
1.	 Déployez ou rabattez l’écran ou appuyez sur le bouton d’alimentation  pour mettre le microscope en MARCHE 

ou à l'ARRÊT.
2.	 Positionnez la lentille sur l’objet et réglez la luminosité de la LED à l’aide du bouton de réglage de la luminosité.
3.	 Ajustez la molette de mise au point pour obtenir une image nette.
4.	 Faites tourner la bague d’objectif polarisant pour réduire l’éblouissement.

	 Il faudra peut-être attendre quelques minutes pour que l’équilibre des blancs s’ajuste de manière auto-
matique et rende l’image nette. Si l’objet est trop éblouissant, pensez à réduire la luminosité de la LED  
(ou à l’éteindre complètement).

b)	Fort et faible grossissement

1Fort grossissement
•	 Tournez la molette de mise au point à fond vers la gauche « + », puis revenez lentement en arrière jusqu’à ce que 

l’image soit nette.
•	 La distance focale sera courte, vous devrez donc peut-être positionner l’objectif beaucoup plus près de l’objet.

2Faible grossissement
•	 Tournez la molette de mise au point à fond vers la droite « - », puis revenez lentement en arrière jusqu’à ce que 

l’image soit mise au point.

c)	Zoom numérique
1.	 Utilisez la bague de mise au point pour mettre l’objet au point sur l’écran LCD.
2.	 Appuyez sur  pour faire un zoom avant + ou arrière -.

d)	Sélectionnez le mode photo ou vidéo
1.	 Appuyez sur  pour basculer entre les modes photo et vidéo.

	- Mode photo :  s’affiche à l’écran.
	- Mode Vidéo :  s’affiche à l’écran.

2.	 Appuyez sur le bouton de capture  pour prendre une photo ou démarrer/arrêter l’enregistrement. 

	 Une icône rouge clignotante  indique que l’enregistrement est en cours.
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e)	Lecture de photos/vidéos
1.	 Appuyez sur  jusqu’à ce que l’icône de lecture  s’affiche.
2.	 Appuyez sur ▲/ ▼pour sélectionner une photo ou une vidéo.

	- La photo est indiquée par le symbole .
	- La vidéo est indiquée par le symbole . Appuyez sur OK pour lire la vidéo sélectionnée.

3.	 Appuyez sur la touche  pour afficher d’autres options telles que « Delete », « Protect » (empêcher la suppres-
sion accidentelle) et « Slide Show ». 
	- Appuyez sur la touche ▲/▼ pour sélectionner un élément du menu.
	- Appuyez sur OK pour sélectionner.

10.	Menu de configuration
a)	Accéder au menu de configuration.
1.	 Appuyez sur , puis sur ▲/ ▼ pour sélectionner une photo ou une vidéo.

	- La photo est indiquée par le symbole .
	- La vidéo est indiquée par le symbole . 

2.	 Appuyez sur  pour accéder au menu de configuration pour la photo ou la vidéo :
	- Appuyez sur ▲/ ▼pour naviguer/changer de valeur.
	- Appuyez sur OK pour sélectionner.
	- Appuyez sur  pour retourner au menu précédent.

b)	Options du menu
Option du menu Description
PhotoResolution Sélectionner la qualité de l’image.
VideoResolution Sélectionner la qualité de la vidéo.
WhiteBalance Photo uniquement : Choisir entre « Auto » et « Daylight ».
LoopRecording Vidéo uniquement : La vidéo continue de s’enregistrer en tant que nouveau clip après 

l’intervalle fixé. 
Time-lapseCapture Photo uniquement : Définir le nombre d’images à prendre sur une période donnée.
DateStamp Afficher l’heure et la date sur l’image.

Date/Time Régler la date et l’heure actuelles.
AutoPowerOff Définir une heure d’arrêt automatique si aucune activité n’est détectée.
Language Définir la langue d’affichage (anglais ou allemand)
TVOut Sélectionnez NTSC ou PAL.
Format Formater la carte MicroSD.
DefaultSetting Restaurer tous les réglages d’usine par défaut.
Version Informations sur la version du micrologiciel.
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11.	Logiciel PortableCapture Plus

 Important : 
•	 Lorsque vous êtes connecté à un ordinateur, les fonctions des boutons ne sont pas actives. Utilisez le 

logiciel « PortableCapture Plus » pour contrôler le microscope.
•	 Les images et les vidéos enregistrées lorsque l’appareil est connecté à un ordinateur sont sauvegardées 

sur le disque dur de l’ordinateur.

a)	Téléchargez et installez le logiciel
1.	 Visitez le site : www.conrad.com/downloads .
2.	 Saisissez le numéro d’ordre : 2176727.
3.	 Sélectionnez le fichier à télécharger.
4.	 Choisissez le dossier qui correspond au système d’exploitation de votre ordinateur (Windows® ou Mac), puis 

sélectionnez « PortableCapture_Plus » pour installer le logiciel.
5.	 Suivez les instructions qui s’affichent à l’écran pour terminer la procédure d’installation.
6.	 Exécutez le logiciel en cliquant sur l’icône générée sur le bureau après l’installation.

	 Changez la langue d’affichage, par ex. Options > Language > German.

b)	Se connecter au microscope
1.	 Connectez une extrémité du câble USB au port USB de votre microscope, et l’autre extrémité à un port USB-A 

de votre ordinateur.
2.	 Si vous vous connectez pour la première fois, attendez quelques instants pour que votre ordinateur télécharge les 

pilotes nécessaires et configure le microscope comme un nouveau périphérique. Suivez les instructions à l’écran.
3.	 Lancez le logiciel « PortableCapture Plus ». 
4.	 Appuyez sur le bouton d'alimentation  pour mettre le microscope en MARCHE.
5.	 Appuyez sur ▲/ ▼pour sélectionner « PCCamera », puis appuyez sur OK pour effectuer la sélection.

	 Relancez le logiciel si l’image du microscope n’apparaît pas dans la zone de prévisualisation de l’image du 
logiciel. 
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c)	Aperçu
B1
B2

B3

B4

B5

B6

B7

B1	 Éléments du menu :
	- File > Photos/Videos Folder : Le dossier de votre ordinateur dans lequel les images prises sont stockées.
	- Options > Resolution : Modifiez la résolution de la capture d’image.
	- Options > Date /Time : Afficher/masquer la date et l’heure de l’enregistrement sur la photo ou la vidéo.
	- Options > Language : Modifier la langue de l’interface utilisateur.
	- Options > XY Guide : Afficher/masquer les lignes de guidage.

B2	 Raccourcis : Caméra/Vidéo/Minuteur/Plein écran/Importation 

B3	 Lignes guides des axes X et Y
B4	 Zone de prévisualisation des images
B5	 Informations sur le grossissement
B6	 Onglet Photo/Vidéo : Sélectionnez un onglet pour visualiser les Photos ou Vidéos enregistrées.
B7	 Fenêtre des images enregistrées (vue miniature).

	- Les images capturées ou les vidéos enregistrées s’affichent en miniature.
	- Si vous placez le curseur de la souris sur une miniature, l'image apparaîtra dans la zone de prévisualisation (B4).
	- Faites un clic droit sur l’image pour avoir plus d’options, notamment Open, Save as, Copy, Delete, Delete All.
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d)	Prise de photo 
1.	 Positionnez le microscope de manière à rapprocher l’objectif de la caméra de l’objet et à l’orienter vers celui-ci.
2.	 Tout en observant la zone de prévisualisation de l’image (B4), faites la mise au point de l’image en utilisant la 

molette de mise au point.

3.	 Pour capturer l’image, sélectionnez l’icône de raccourci de la caméra .
4.	 Les photos seront enregistrées à l’emplacement File > Photos Folder.

	 Les images capturées s’affichent en miniature dans la fenêtre des images enregistrées (B7). Si vous 
placez le curseur de la souris sur une miniature, l'image apparaîtra dans la zone de prévisualisation (B4). 
Les images sont enregistrées en format JPG.

e)	Enregistrement des vidéos
1.	 Positionnez le microscope de manière à rapprocher l’objectif de la caméra de l’objet et à l’orienter vers celui-ci.
2.	 Tout en observant la zone de prévisualisation de l’image (B4), faites la mise au point de l’image en utilisant la 

molette de mise au point.

3.	 Pour lancer l’enregistrement, sélectionnez l’icône de raccourcis des vidéos .L’icône clignote pour indiquer que 
l’enregistrement a démarré.

4.	 Cliquez sur l’icône qui clignote pour arrêter l’enregistrement.
5.	 Les vidéos seront sauvegardées à l’emplacement File > Videos Folder.

	 Les vidéos enregistrées s’affichent en miniature dans la fenêtre des images enregistrées (B7). Si vous 
placez le curseur de la souris sur une miniature, l'image apparaîtra dans la zone de prévisualisation (B4). 

f)	 Minuteur photo et vidéo

.

Vous pouvez définir une minuterie de démarrage et d’arrêt personnalisée pour 
capturer des photos ou enregistrer des vidéos.

1.	 Sélectionnez le raccourci de la Minuterie  puis choisissez une Photo ou 
une Vidéo.

2.	 Définissez les paramètres souhaités.
3.	 Sélectionnez Start pour lancer l’enregistrement.

	 L’enregistrement s’arrêtera une fois que le programme aura parcouru 
les paramètres, ou si vous sélectionnez Stop pour arrêter la minuterie. 
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g)	Marquage de l’image/commentaire
Double-cliquez sur une image dans la fenêtre des images sauvegardées (B7) pour accéder à l’interface de marquage/
commentaire de l’image.

	- Icône de marquage .
	- Icône de commentaire 

	 Un menu déroulant affiche diverses options à côté de chaque icône.

h)	Outils de mesure de la taille des images
Double-cliquez sur une image dans la fenêtre des images enregistrées (B7) pour accéder à l’interface de mesure, 
puis sélectionnez l'icône  de mesure.

 Important : 
Pour des mesures précises, vous devez étalonner le logiciel. Voir la section « Logiciel PortableCapture Plus 
→ h) Étalonnage ».

•	 Any Angle Line. Cliquez et faites glisser le curseur d’un point à l’autre.
•	 Continuous Line. Cliquez et faites glisser le curseur d’un point à plusieurs 

points.
•	 Radius Circle. Cliquez et faites glisser le curseur pour élargir le rayon.
•	 Diameter Circle. Cliquez et faites glisser le curseur pour augmenter le diamètre.
•	 Three Points Angle. Cliquez et faites glisser le curseur d’un point à un autre, 

mesurez l’angle puis cliquez pour relâcher. 

i)	 Étalonnage
	 Vous aurez besoin d’une règle pour l’étalonnage.

1.	 Sélectionnez : Options → Crossing → On.
2.	 Concentrez le microscope sur la règle.
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3.	 Faites tourner la molette de mise au point jusqu’à ce que l’image devienne nette. 
4.	 Ajustez la position de la règle afin que l’image soit alignée en carré avec les bandes de lignes de guidage XY.
5.	 Prenez une photo de l’image lorsque la zone sélectionnée est alignée avec le passage à niveau comme indiqué.
6.	 Double-cliquez sur l’image de la règle dans la fenêtre des images enregistrées (B7) pour accéder à l’interface 

« Image Preview ».

1.000

1.000

7.	 Sélectionnez l’icône d’étalonnage  → Calibration.
8.	 Cliquez et faites glisser le curseur pour sélectionner le point de départ et le point final à travers une valeur connue, 

par ex., l’incrément de 1 mm le long de la règle.
9.	 Lorsque la boîte de dialogue s’ouvre, entrez la valeur exacte de l’échantillon de mesure dans le champ Dimension 

actuelle. Le logiciel calculera le grossissement. 
10.	Sélectionnez « OK » pour confirmer. La valeur de grossissement ajustée apparaîtra dans le coin supérieur droit.

j)	 Vérifiez l’étalonnage
1.	 Double-cliquez sur l’image de la règle dans la fenêtre des images enregistrées (B7) pour accéder à l’interface 

« Image Preview ».

2.	 Sélectionnez l’icône de mesure .
3.	 Sélectionnez « Any Angle Line » dans le menu déroulant, puis cliquez et faites glisser les points de départ et 

d’arrivée sur 1 mm sur la règle.
4.	 L’étalonnage est réussi si la valeur de la règle du logiciel est identique à la valeur de l’incrément mesuré sur la règle.
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12.	Sortie pour T.V. / moniteur
Vous pouvez utiliser votre écran de téléviseur ou d’ordinateur comme un grand écran de visualisation. Reportez-vous 
au mode d’emploi de votre téléviseur ou de votre moniteur pour obtenir des informations sur la visualisation des 
entrées HDMI.
1.	 Connectez une extrémité du câble HDMI fourni à la sortie HDMI-out du microscope, et l’autre extrémité à une 

entrée HDMI disponible sur le téléviseur ou le moniteur.

	 Vous pouvez également connecter via le port TV-out  à l’aide du câble AV.

2.	 Appuyez sur le bouton d'alimentation  pour mettre le microscope en MARCHE.
3.	 Appuyez sur la touche mode  pour passer du mode photo au mode vidéo.

	- Une icône  indique que vous êtes en mode photo.
	- Une icône  indique que vous êtes en mode vidéo.
	- Une icône   indique que vous êtes en mode de lecture.

4.	 Appuyez sur  pour accéder à la configuration.
5.	 Appuyez sur ▲/ ▼pour aller à « TV Out », puis appuyez sur OK.
6.	 Appuyez sur ▲/ ▼pour aller à « NTSC » ou « PAL », puis appuyez sur OK.
7.	 Appuyez sur  pour quitter la configuration du microscope.

13.	Support de trépied
	 N’usez pas de la force pour visser le trépied au support, 

car cela risque d’endommager le trou de la vis.

14.	Entretien et nettoyage
	 N’utilisez pas de produit de nettoyage agressif, d’alcool isopropylique ou toute autre solution chimique,  

car ils peuvent endommager le boîtier et engendrer des dysfonctionnements.

•	 Avant le nettoyage, débranchez le produit de l’alimentation électrique.
•	 Nettoyez le produit à l'aide d'un chiffon sec et sans fibres.
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15.	Élimination des déchets
a)	Produit

Tous les équipements électriques et électroniques mis sur le marché européen doivent être marqués de 
ce symbole. Ce symbole indique qu'à la fin de sa durée de vie, cet appareil doit faire l’objet d’une collecte 
séparée des déchets ménagers non triés.
Chaque propriétaire d'appareils usagés a l’obligation de les ramener dans un centre de tri où les appareils 
seront recyclés. Avant de ramener les appareils usagés dans un centre de collecte, les utilisateurs finaux 
sont tenus d’en retirer les piles et les accumulateurs usagé(e)s, le cas échéant lorsque celles-ci ne sont 
pas scellées dans l'appareil et qu’il est possible de les retirer sans les détruire, par ex. dans les lampes.

Les distributeurs d’équipements électriques et électroniques sont légalement tenus de reprendre gratuitement les 
appareils usagés. Conrad vous offre les possibilités de retour gratuit suivantes (plus d’informations sur notre site 
Internet) :
•	 auprès de nos magasins Conrad
•	 auprès de centres de collecte gérés par Conrad
•	 dans les points de collecte des autorités publiques chargées de l’élimination des déchets ou auprès des systèmes 

de reprise mis en place par les fabricants et les distributeurs au sens de la loi sur les équipements électriques et 
électroniques (ElektroG)

L’utilisateur final est responsable de la suppression des données personnelles figurant dans l’appareil à éliminer. 
Veuillez noter que dans tout pays autre que l’Allemagne, d’autres obligations sont susceptibles de s’appliquer pour la 
reprise et le recyclage des déchets.

b)	Piles/accumulateurs
Retirez les piles/accus éventuellement insérés et éliminez-les séparément du produit. Le consommateur final est 
légalement tenu (ordonnance relative à l’élimination des piles usagées) de rapporter toutes les piles/accumulateurs ; 
il est interdit de les jeter dans les ordures ménagères.

Les piles/accumulateurs qui contiennent des substances toxiques sont caractérisées par les symboles ci-
contre qui indiquent l’interdiction de les jeter dans les ordures ménagères. Les désignations pour le métal 
lourd prépondérant sont : Cd = cadmium, Hg = mercure, Pb = plomb (la désignation se trouve sur les piles/
accumulateurs, par ex. sous le symbole de la poubelle illustré à gauche).

Vous pouvez rapporter gratuitement vos piles/accumulateurs usagé(e)s aux centres de récupération de votre com-
mune, à nos succursales ou à tous les points de vente de piles/accumulateurs. Vous respectez ainsi les ordonnances 
légales et contribuez à la protection de l’environnement.
Avant la mise au rebut, recouvrez complètement les contacts exposés des piles/accumulateurs avec un morceau de 
ruban adhésif pour éviter les courts-circuits. Même si les piles/accumulateurs sont vides, l’énergie résiduelle qu’elles 
contiennent peut être dangereuse en cas de court-circuit (éclatement, surchauffe, incendie, explosion).
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16.	Caractéristiques techniques
a)	Microscope
Source d’alimentation........................................�Li-ion 3,7 V/1050 mAh (accumulateurs) 5 V/CC, 500 mA (USB 2.0)
Temps de charge de l'accumulateur..................env. 5 heures (via l’adaptateur secteur)
Autonomie de l'accumulateur............................env. 4 heures
Mémoire.............................................................MicroSD, SDHC, SDXC (32 Go max.)
Système de fichier MicroSD..............................FAT32
Langue d’interface.............................................anglais, allemand
Capteur d’images..............................................12 MP
Résolution de la caméra....................................�12 M, 10 M, 8 M,5 M, 3 M, 2 M
Plage de mise au point......................................0 - 60 mm (mise au point manuelle)
Grossissement...................................................�Optique : 10 x à 300 x 

Numérique : 1.1 x à 4.0 x
Format d’image..................................................JPG
Format vidéo......................................................MOV
Résolution vidéo................................................1920 x 1080 p, 1280 x 720 p
Fréquence d’images par seconde.....................30 ips max.
LED....................................................................500 LUX max. (blanc)
Conditions de fonctionnement...........................10 à +40 °C, 40 à 85 % d'humidité relative (sans condensation)
Conditions de stockage.....................................-5 à +50 °C, 40 à 85 % d’humidité relative (sans condensation)
Dimensions (l x h x p)........................................108 x 160 x 37 mm
Poids..................................................................213 g (avec l'accumulateur)
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b)	Logiciel
Systèmes d’exploitation pris en charge.............�Windows® 7/8/10 (32/64 bit), Mac OS 10.14 ou version supérieure.

c)	Adaptateur secteur
Tension d’entrée................................................100 - 240 V/CA
Fréquence du CA d’entrée.................................50/60 Hz
Tension de sortie...............................................5,0 V
Courant de sortie...............................................1,0 A
Puissance de sortie...........................................5,0 W
Rendement moyen en mode actif......................≥73,62 %
Rendement à faible charge (10 %)....................N/A
Consommation électrique hors charge..............≤0,10 W
Référence du modèle........................................DSA-5PF02-05 FEU 050100

Numéro d'enregistrement au registre du commerce : HRB 3896

Fabricant : Conrad Electronic SE, Klaus-Conrad-Str. 1,  
D-92240 Hirschau - Allemagne
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